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 مقذمٍ .1

 َذف.1.1

ٞبیی ثشای اػت. ایٗ خٛدآٔٛص ثب دػتٛساِؼُٕ PICٞذف ایٗ ٘ٛؿتبس فشاٞٓ آٚسدٖ خٛدآٔٛصی وٛتبٜ ٚ ػبدٜ ثشای ثش٘بٔٝ سیضی ٔیىشٚوٙتشِشٞبی 

 سػذ.ثٝ پبیبٖ ٔی Breadboardؿٛد ٚ ثب ثؼتٗ ٔذاس آٖ ثش سٚی ٔٙبػت آغبص ٔی PICا٘تخبة 

 . قزاردادَای وًشتار1.1

دٞذ اعلاػبت ٔختّف سا اص یىذیٍش خذا وٙٙذ. اػت وٝ ثٝ خٛا٘ٙذٜ اخبصٜ ٔیٞبی ٌٛ٘بٌٖٛ ا٘تخبة ؿذٜٔختّفی ثشای ٘ٛؿتٝدس ایٗ ٘ٛؿتبس ا٘ٛاع 

 ؿٛ٘ذ. ثٝ ػٙٛاٖ ٔثبَ:ٚ ثٝ صٛست سٍ٘ی ٘ٛؿتٝ ٔی Courierوذٞب ٚ ؿجٝ وذٞب ثب فٛ٘ت 

#include <stdio.h> 

void main(int argc, char *argv[]) 

{ 

printf("Star Wars!\n”); 

return; 

} 

-٘ٛؿتٝ ٔی ثٝ ایٗ صٛستؿٛ٘ذ.٘ىبت ٟٔٓ ٘یض ثب پغ صٔیٙٝ خبوؼتشی ٔی)تٛ پش( ٘ٛؿتٝ Boldٚ ثٝ صٛست  Arialٞب ٚ ٔٙٛٞب ثب فٛ٘ت دوٕٝ

 ؿٛ٘ذ.

 . چٍ کساوی ایه کتاب را تخًاوىذ ي کتة پیشىُادی1.1
ٔٙذ ثٝ دا٘ؼتٗ ٔفبٞیٓ اِٚیٝ دسثبسٜ ثؼلاٜٚ ػبیش دا٘ـدٛیبٖ ٚ وؼب٘ی وٝ ػلالٝٞبی ثشق ٚ وبٔپیٛتش٘ذ. ٔمصٛد اصّی ایٗ ٘ٛؿتبس دا٘ـدٛیبٖ سؿتٝ

 ٔٙذ ؿٛ٘ذ.تٛا٘ٙذ اص ایٗ وتبة ثٟشٜٞؼتٙذ  ٔی PIC٘ٛیؼی ثشای ٔیىشٚوٙتشِشٞبی ثش٘بٔٝ

 وٙذ:چٙذیٗ وتبة پیـٟٙبدی دس ایٗ ساثغٝ ٚخٛد داسد وٝ فٟشػت صیش ثخـی اص آ٘بٖ سا ٔؼشفی ٔی

 Introduction to microelectronic systems: the PIC 16F84 microcontroller by Martin Bates. 

 PIC microcontroller: an intro to software and hardware interfacing by Han-Way Huang. 

 The PIC microcontroller: your personal introductory course by John Morton. 

 PIC microcontroller project book by John Lovine. 

 Programming and customizing the PIC microcontroller by Myke Predko. 

 The quintessential PIC microcontroller by Sid Katzen. 

ثش٘بٔٝ ٘ٛیؼی دس  اػت ٚ ثشای دا٘ـدٛیب٘ی وٝ لصذٞب ثٝ صثبٖ اػٕجّی ٘ٛؿتٝ ؿذٜافضاسٞبی ایٗ وتبةتش ٘شْ٘ىتٝ: ثٙب ثٝ تدشثٝ ؿخصی ثیؾ

 ػغٛح ثبلا سا داس٘ذ ٔفیذ ٘یؼت.
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 PICاوتخاب میکزيکىتزلز  .1

 . مقذم1.1ٍ

-ٚ ٚػبیُ خب٘جی داخّی وٝ ٔیی  Bus ثب حبفظٝ،  Microchip Technologyٞبی ٔحجٛثی ٞؼتٙذ وٝ تٛػظ پشداص٘ذٜ PICٔیىشٚوٙتشِشٞبی 

اػیت ویٝ    Programmable Intelligent Computerٔخفیف   PICتٛا٘ٙذ ثشای وبسٞبی ٔختّف ٔٛسد اػتفبدٜ لشاس ٌیش٘ذ عشاحیی ؿیذ.   

 ؿٛد.ؿٙبختٝ ٔی Peripheral Interface Controllerأشٚصٜ ثٝ ػٙٛاٖ 

 PIC. اوًع 1.1

ٞبی ثیـتشی وٝ دس خذَٚ ثیتی. ٞش دػتٝ خٛد ثٝ صیشؿبخٝ 16ثیتی ٚ  8ؿٛ٘ذ: وٙتشِشٞبی ثٝ دٚ دػتٝ ثضسي تمؼیٓ ٔی PICشِشٞبی ٔیىشٚوٙت

 ؿٛد.ثیٙیذ تمؼیٓ ٔیصیش ٔی

16 Bit 8 bit 

PIC24F 
PIC24H 
dsPIC30 
dsPIC33 

PIC10 
PIC12 
PIC14 
PIC16 
PIC18 

ثیت خضء  16ٞبی PICتٕبٔی ٚ  mid-endاص دػتٝ  PIC18تب  PIC16ٞؼتٙذ ٚ  low-endاص ٔیىشٚٞبی   PIC14تب  PIC10ٞبی خب٘ٛادٜ

 ٞؼتٙذ.High-endوٙتشِشٞبی 

 PIC16F877/Aثیشای ایٍٙٛ٘یٝ ٔیٛاسد     PICاحتیبج داس٘ذ. پش اػتفبدٜ تشیٗ   mid-levelٞب ثٝ وٙتشِشٞبی ٘ىتٝ: اوثشیت دا٘ـدٛیبٖ ٚ پشٚطٜ

 اػت.

 ٞب داسد. ا٘تخبة دسػت ثشای پشٚطٜ ؿٕب ثٝ فبوتٛسٞبی ٔتؼذدی ٚاثؼتٝ اػت:PICٞب خبف خٛد ٚ تفبٚتٟبی سیضی ثب دیٍش ٚیظٌی  PICٞش 

 آیب ایٗ پشٚطٜ ٘یبص ثٝ ٚسٚدی ٚ خشٚخی آ٘بِٛي داسد؟ 

 آیب ایٗ پشٚطٜ ٘یبص ثٝ ٚسٚدی ٚ خشٚخی دیدیتبَ داسد؟ 

 ٔٛسد ٘یبص اػت؟  I/Oچٙذ پیٗ  

 لیمی ٘یبص داسد؟آیب پشٚطٜ ثٝ صٔب٘جٙذی د 

 چٝ ٔمذاس حبفظٝ ٔٛسد ٘یبص اػت؟ 

 ػشیبَ ٔٛسد ٘یبص اػت؟ I/Oآیب  

 ...ٚ 

 ٞبی ٔختّفی اسائٝ ؿذٜ اػت:دس پىیچ PICٕٞچٙیٗ 

 Plastic Dual Inline Package (PDIP) 

 Small-Outline Transistor (SOT) 

 Dual Flat No-lead (DFN) 

 Mini Small Outline Package (MSOP) 

 Thin Quad Flat Pack (TQFP) 

 Plastic Leaded Chip Carrier (PLCC) 

 CERamic QUADpack (CERQUAD) 

ٚخٛد داسد. ػٕذتب ٔیىشٚوٙتشِشٞب ٔؼتغیّی یب ٔشثؼی ؿىُ  I/Oپبیٝ  100ٞب ثب PICٞبی ٔختّف آٖ اػت وٝ ثؼضی دِیُ ٚخٛد پىیح

 وبسی ساحت تش٘ذ.اػت ٚثشای  ِحیٓ Breadboardاػت چشاوٝ لبثُ ثؼتٗ سٚی  PDIPیب  DIPتشیٗ پىیح ثشای وبس ٞؼتٙذ. ساحت
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 SOPثؼٛصا٘یذ ٚ  Quad Chipتبسٖ سا سٚی یه تٛا٘یذ ثش٘بٔٝاػتفبدٜ وٙیذ. ؿٕب ٕ٘ی DIPثب پىیح  mid-level ٘ىتٝ:اص یه ٔیىشٚ

Chip ٝٞب ٘یض ٘یبص ثSchmartboard.ٞب داس٘ذ 

 (IDEمحیط تًسعٍ مجتع ) .1
اػیت ویٝ تٛػیظ     MPLab IDEٞیب  PICثشای وبس ثب  IDEاػتفبدٜ وشد.ثٟتشیٗ  IDEٞب ثبیذ اص یه افضاس خٛد ٚ ػبصٔب٘ذٞی فبیُ٘شْ ثشای تٛػؼٝ

Microchip Technology ٜاػت. ٘ٛؿتٝ ؿذMPLab IDE    تٛا٘ییذ ثیٝ تبسٕ٘یبی    سایٍبٖ ٚ آػبٖ اػت. ثشای دسیبفت آخیشیٗ ٘ؼیخٝ آٖ ٔیی

http://www.microchip.com  ٔشاخؼٝ وٙیذ. 

 .ؿٛ٘ذ ٘ؼخٝ ٔٛلتی ٞؼتٙذٞبیی وٝ ثب صفش تٕبْ ٕ٘ی( فبیv7.50ُؿٛد. )ثٝ ػٙٛاٖ ٔثبَ ثب صفش ختٓ ٔی MPLab IDEتٛخٝ: آخشیٗ ٘ؼخٝ 

آٖ سا  MPLab IDEپغ اص دسیبفت  سا دسیبفت وٙیذ. MPLab IDEتٛا٘یذ سإٞٙبی وبسثش، ٕ٘ٛداس ػشیغ ٚ سإٞٙبی ػشیغ وبسثش ٕٞچٙیٗ ٔی

 ٘صت وٙیذ.

 َای تزوامٍ وًیسیستان .1

PICٖٞبی ٞب ثب صثبC،Assembly ٝٔای تٛػظ ٞبی ػغح ثبلا ٔی تٛا٘ٙذ وٝ ثٝ صٛست پبیٝػبیش صثبٖ٘ٛیؼی اػت.یب ٔخّٛعی اص ایٗ دٚلبثُ ثش٘ب

C ٜا٘ذ ٘یض لبثُ اػتفبدٜ دس ٘ٛؿتٝ ؿذEmbedded System .دس صیش ػٝ ٕ٘ٛ٘ٝ ثش٘بٔٝ سا خٛاٞیذ دیذ: ٞب ٞؼتٙذ 

Example 1 – Assembly 
MAIN 

Clrf  PORTB  ;Clear PORTB output latches 

Bsf  STATUS,RP0 ;Switch to bank 1 

Movlw  b'11110000' ;Load value to make lower 4 bits outputs 

Movwf  TRISB  ;Move value to TRISB 

Bcf  STATUS,RP0 ;Switch to bank 0 

LOOP 

Bsf  PORTB,0  ;Turn on LED on RB0 

Call  DELAY  ;Call delay routine 

Bcf  PORTB,0  ;Turn off LED on RB0 

Call  DELAY  ;Call delay routine 

Goto  LOOP  ;Repeat main loop 

DELAY 

Decfsz COUNTERL ;Decrement COUNTERL 

Goto  DELAY  ;If not zero, keep decrementing COUNTERL 

Decfsz COUNTERH ;Decrement COUNTERH 

Goto  DELAY  ;If not zero, decrement COUNTERL again 

return 

END 

 

Example 2 – Assembly and C 
main() 

{ 

short first_pass = TRUE; 

//----- Set up port direction reg's ----- 

#asm 

movlw 0 // Set port b to outputs 
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tris port_b 

clrf port_b 

movlw 0xff // Set port a to inputs 

tris port_a 

#endasm 

//----- Wait for powerup, Initilize LCD ----- 

delay_ms(200); 

init_lcd(); 

//----- Write a startup message ----- 

msg_1(); 

//----- Write status message ----- 

msg_2(); 

… 

 

Example 3 – C 
void main() { 

U8 i = 0; // General purpose loop var. 

U16 num ; // General purpose number var. 

U8 row = 0; // Current display row. 

U16 blinkc = 0; // LED blinker counter. 

U16 blink_onoff = 1; // LED state. 

U8 bcd_h,bcd_m,bcd_s; // BCD numbers. 

init_ports(); 

init(); 

enable_interrupts(); 

ROW_RESET; 

///////////////////////////// 

for (;;) { // infinite loop 

// FLASH LED @ RA3 

if (++blinkc>500) { // time to change state ? 

blinkc=0; 

… 

 تش اػت.تش ٚ ساحتشا وٝ ٘ٛؿتٗ آٖ ػشیغثٙٛیؼیذ چ Cوٙیٓ وٝ وذٞبی خٛد سا ثٝ صثبٖ پیـٟٙبد ٔی

 ایذ.وٙیذ ٚاثؼتٝ ثٝ وٕپبیّشی اػت وٝ ثشای پشٚطٜ خٛد ا٘تخبة وشدٜوٝ ثشای ٘ٛؿتٗ وذٞبی خٛد ا٘تخبة ٔی Cای اص صثبٖ ٘ىتٝ: ٘ؼخٝ

 ز، اسمثلز ي لیىکزلکمپای .5

وٕپبیّش، اػٕجّش ٚ ِیٙىش ػٕٛٔب دس یه  ثؼتٝ  وٕپبیّش ثشٌضیٙیذ.ثؼذ اص دسیبفت، ٘صت ٚ ا٘تخبة صثبٖ ثش٘بٔٝ ٘ٛیؼی ٔٛسد ٘ظشتبٖ ؿٕب ثبیذ یه 

. ثٝ  Option Project →Select Language Toolsuiteٔٙٛ یب ا٘تخبة  Project Wizardاص عشیك  MPLab IDEدس  ٚاحذ لشاس داس٘ذ.

 ؿىُ صیش تٛخٝ وٙیذ.
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 MPLab IDEاوتخاب کمپایلز در : 1 شکل

ٕٞشاٜ  ٞبی سایٍبtoolsuiteٖٔٙذ ثٝ فشض ٘صت ٘یؼتٙذ ٚ ٌشاٖ لیٕتٙذ. ثٝ ػٙٛاٖ یه دا٘ـدٛ احتٕبلا ػلالٝٞب ثصٛست پیؾtoolsuiteاغّت 

MPLab IDE  (Microchip MPASM Toolsuite   ٚCCS C Compiler for PIC12/24/26/18 ٞؼیتیذ ).    ػیبیش وٕپبیّشٞیبی

 ٔدتٕغ ٌشدد سٚی ٚة ٚخٛد داسد. MPLab IDEتٛا٘ٙذ دس سایٍبٖ وٝ ٔی

ٞبی پـتیجب٘ی ؿیذٜ دس ِیؼیت صییش    ٘بػبصٌبس اػت. ثٝ دػتٍبٜ PICسایٍبٖ اػت أب ثب خیّی اص ٔیىشٚوٙتشِشٞبی  CCS C Compilerتٛخٝ: 

 ?page=deviceshttp://www.ccsinfo.com/devices.phpتٛخٝ وٙیذ: 

 

سػییذْ ویٝ دس    HI-TECH PICC-Liteٌـیتٓ. ثیٝ وٕپیبیّش     Cثٝ دِیُ ٘ىتٝ روش ؿذٜ دس ثبلا دس ایٙتش٘ت ثٝ د٘جبَ ییه وٕپیبیّش سایٍیبٖ    

http://htsoft.com/products/PICClite_comparison.php  ٚخٛد داسد وٝ ثٝ ساحتی لبثُ ٘صت ٚ ٔدتٕغ ػبصی ثبMPLab IDE 

 اػت.

 MPLab IDEاستفاده از  .6

های و پنجره Workspaceرا باز کنید و  MPLab بنویسیم. Cیک برنامه به زبان  MPLab IDEبیایید با ساخت یک پروژه جدید در 

 صورتی سلسله مراتبی و راحت سازماندهی می کند.های پروژه را به فایل Workspaceخروجی را مشاهده کنید. پنجره 

 .را دنبال کنید Project→Project Wizardبرای ساخت یک پروژه جدید مسیر 
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 MPLab IDEساخت یک پزيصٌ جذیذ در  :1 شکل

 ٔذٌٛیی ٔغبثك ؿىُ صیش ثبص خٛاٞذ ؿذآپٙدشٜ خٛؽ

 

 آمذ گًیی تزای ساخت پزيصٌ جذیذخًش: پىجزٌ 1 شکل
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سا ثض٘یذ ٚ ػپغ ٚاسد ثخؾ ا٘تخبة دػتٍبٜ خٛاٞیذ ؿذ. دس ایٗ پٙدشٜ تٟٙب یه فٟشػت ثبصؿذ٘ی ثیب تؼیذاد صییبدی ٔیىشٚوٙتشِیش      Nextدوٕٝ 

PIC ٖٞب ا٘تخبة وٙیذ.ٚخٛد داسد وٝ ثبیذ دػتٍبٜ ٔٛسد ٘ظشتبٖ سا اص ٔیبٖ آ 

سا ثض٘یذ تب ٚاسد ٔشحّٝ دْٚ وٝ ا٘تخیبة صثیبٖ     Nextثؼذ اص ا٘تخبة دػتٍبٜ ٔٛسد ٘ظش دوٕٝ 

toolsuite ؿٛیذ. وٕپبیّش ٔٛسد ٘ظش خٛد سا ا٘تخبة وٙیذ ٚ دوٕٝ اػت ٔیNext .سا ثض٘یذ 

ثشای پیشٚطٜ ا٘تخیبة وٙییذ ٚ     ٔؼیشدس ٔشحّٝ ػْٛ وٝ ا٘تخبة ٘بْ پشٚطٜ اػت ثبیذ ٘بْ ٚ یه 

 ا ثض٘یذ.س Nextدوٕٝ 

 ا٘ذ:ا٘ٙتخبة ؿذٜ Desktopٚ فِٛذس  MyProjectدس ایٗ ٔثبَ ٘بْ 

 

 : اوتخاب دستگا1ٌ شکل

 گذاری پزيصٌ: وام5 شکل

 

ٞبی اضبفٝ وٙیذ. ٔثبَ فبیُٞبی ٔٛسد ٘یبص خٛد سا ثٝ ٔؼیش پشٚطٜ دٞذ وٝ فبیُٞبی ٔٛخٛد ثٝ پشٚطٜ ثٝ ؿٕب اخبصٜ ٔیافضٚدٖ فبیُ ٔشحّٝ چٟبسْ:

)دس اییٗ   سا ثض٘ییذ.  Nextٞش فبیُ ٔٛسد ٘یبص سا ثٝ پشٚطٜ خٛد اضبفٝ وٙییذ ٚ دوٕیٝ    ٞؼتٙذ. <pic.h> ،<stdlib.h>  ٚ<string.h> ٔٛسد ٘یبص

 ٔثبَ ایٗ ٔشحّٝ سا سد وشدیٓ(

دس  lcd.h ،lcd.c ،delay.h ،delay.cٞبی ٔفیذ ثؼیبسی ٔب٘ٙذ وٙیذ فبیُاػتفبدٜ ٔی HI-TECH PICC-Lite٘ىتٝ: اٌش اص وٕپبیّش 

 تٛا٘ذ ؿٕب سا دس پشٚطٜ وٕه وٙذ.ٚخٛد داسد وٝ ٔی HI-TECH Software\PICC-Lite\9.50\samples/ٔؼیش 

 

 سا فـبس دٞیذ. Finishٔٙبػت اػت دوٕٝ  ایذ. اٌش ٕٞٝ چیضایؼت اص آ٘چٝ وٝ ا٘تخبة وشدٜػبخت پشٚطٜ، خلاصٝ Wizardآخشیٗ پٙدشٜ دس 
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 : آخزیه صفحٍ ساخت پزيصٌ جذیذ6 شکل

دٞذ ایٗ فبیُ ثٝ وبسثش اخبصٜ ٔیوٙذ. ػبصی ػٛاَ ٔیسا ثشای رخیشٜ Workspaceؿٛد وٝ ٔؼیش فبیُ ای ثبص ٔیپغ اص ٔشحّٝ پبیب٘ی پٙدشٜ

 سا ثب ٔؼیش پشٚطٜ ٚاسد وٙیذ.  Workspaceچٙذیٗ ػٛسع ٚ ٔٙجغ ٔختّف  سا خٕغ آٚسی ٚ ػبٔب٘ذٞی وٙذ. ٘بْ ٔشثٛط ثٝ 

 
 Workspace: اوتخاب مسیز 7 شکل

 اوٖٙٛ ؿبُٔ ٕ٘بی ػّؼّٝ ٔشاتجی فِٛذسٞب ثشای پشٚطٜ ؿٕبػت. Workspaceپٙدشٜ 
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 افشاروًشته وزم .7

 PICٞبی ٔیىشٚوٙتشِش اص پبیٝ PORTAسا وٝ ثٝ  LED٘ٛیؼیٓ. ثش٘بٔٝ صیش یه ٔی MPLab IDEثب اػتفبدٜ اص  Cاوٖٙٛ یه ثش٘بٔٝ پبیٝ ثٝ صثبٖ 

 ٍ٘بٜ وٙیذ( PICص٘ذ. )ثٝ دیتب ؿیت اػت، سا چـٕه ٔیٚصُ ؿذٜ

main.c 

//LED example program written for 

//PIC programming tutorial. 

//standard include files 

#include <stdlib.h> 

#include <pic.h> 

#include “delay.h” 

//main function 

void main() 

{ 

PORTA = 0x00; //set RA0-RA5 low 

TRISA = 0x00; //set PORTA to output 

//superloop 

while(1) 

{ 

PORTA = !PORTA; 

DelayMs(250); 

} 

} 

ٝ     pic.hفبیُ  ٔٛسد ٘یبص ٞؼتٙذ. stdlib.h  ٚdelay.hٞبی ٚ تبخیشٞب فبیُ Cای ثشای ػّٕیبت پبیٝ ٞیبی  ثیشای دػتشػیی ثیٝ پبیی

I/O  ٔیىشٚوٙتشِشٞبیPICدٞذ وٝ ٞش پبییٝ  ، فضبٞبی حبفظٝ ٚ ػبیش اخضاء لاصْ اػت. دیبٌشاْ صیش ٘ـبٖ ٔیI/O  سٚیPIC16F877A 

 ثٝ وذاْ ٔتغیش دس ثش٘بٔٝ ٘ٛیؼی ٔشثٛط اػت.

 

PORTA  دسmain.c  ٝثیت  6ثI/O  سٚی ٔیىشٚ وٙتشِشPIC .تٛا٘ذ ثب اػتفبدٜ اص دػتٛسات صیش پبییٗ )صفش( یب ثبلا )یه( ؿٛد. ٞش پبیٝ ٔی اػت

PORTA=0x01  ٝپبیRA0 تٛا٘ٙذ ٔب٘ٙذ دػتٛس وٙذ. چٙذ پبیٝ ٔیسا یه ٔیPORTB=0xFF    ٔمذاس دٞی ؿٛد. ثشای اعلاع اص ا٘یذاصٜ ٚ تؼیذاد

 ٔشاخؼٝ وٙیذ. PICٞب( ثٝ دیتب ؿیت ٔیىشٚوٙتشِش )پٛستٞب دسٌبٜ
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TRISA  ٝیه سخیؼتش وٙتشِی خٟت ٔشثٛط ثPORTA  .اػتTRIS ٞبیی ثشاثش ثب دسٌبٜ ٔشثٛعٝ داسد. اٌش دس تؼذاد ثیتTRIS  لیشاس   1یه ثیت

 دٖ پبیٝ اػت.دادٜ ؿٛد ثٝ ٔؼٙبی آٖ اػت وٝ ایٗ پبیٝ ٚسٚدی خٛاٞذ ثٛد ٚ صفش ثٛدٖ آٖ ثٝ ٔؼٙبی خشٚخی ثٛ

 ٞب اػت.ؿٛد تبثؼی ثشای تٙظیٕبت اِٚیٝ دسٌبٜثش٘بٔٝ صذا صدٜ ٔی main٘ىتٝ: ٔؼٕٛلا اِٚیٗ تبثؼی وٝ دس لؼٕت 

وٙیذ. ػیبختبس، ٞیذف ٚ پیچییذٌی     ٔیّی ثب٘یٝ تبخیش ایدبد ٔی 250سا تغییش دادٜ ٚ  Aؿٛد ٚ ٔمذاس دسٌبٜ ػپغ ثش٘بٔٝ ٚاسد یه حّمٝ اصّی ٔی

 ثشای ٔیىشٚوٙتشِش ٞب ثٝ آدسع صیش ٔشاخؼٝ ٕ٘بییذ. Cثؼتٝ ثٝ وبسوشد ٔیىشٚ ؿٕب اػت. یه ٔٙجغ ٔٙبػت ثشای ثش٘بٔٝ ٘ٛیؼی افضاس ؿٕب ٚا٘شْ

http://www.best-microcontroller-projects.com/programming-microcontrollers-in-c.html 

 PICثی ٔؼٙبػت. ثشای آصٔبیؾ وبسوشد ٚسٚدی/خشٚخی ثبیذ  embeddedٞبی دس ثش٘بٔٝ ()printf()  ٚscanfٔب٘ٙذ  Cتٛخٝ: تٛاثغ اػتب٘ذاسد 

 لشاس ٌشفتٝ ثبؿذ)ٔذاس ثؼتٝ ؿذٜ ثبؿذ( Breadboardسٚی 

 Burningفزایىذ  .8

 Burnآٖ ایشادی ٘ذاؿتٝ ثبؿذ. اِٚیٗ ٌبْ ثشای  Syntscsٍٞٙبٔی وٝ ثش٘بٔٝ خٛد سا ٘ٛؿتیذ ثبیذ اثتذا آٖ سا وٕپبیُ وٙیذ تب ٔغٕئٗ ؿٛیذ وٝ 

ٞبی پیىشثٙذی ثٝ دسػتی اختصبف ثش٘بٔٝ اػت. لجُ اص ػبختٗ پشٚطٜ خٛد اعٕیٙبٖ حبصُ وٙیذ وٝ ثیت  وشدٖ )ػبختٗ( Buildوشدٖ ثش٘بٔٝ 

سا ا٘تخبة وٙیذ ٚ  Project→Build Allسا اتخبة وٙیذ. دس پبیبٖ  Configure→Configuration Bitsا٘ذ. ثشای ایٗ وبس  ٔؼیش ٜدادٜ ؿذ

 سا ثض٘یذ. Ctrl+F10یب 

 

 کزدن پزيصٌ Build: 8 شکل
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-پیغبْ) advisory messages)اخغبس( یب  Warningوٙذ. ٕٔىٗ اػت چٙذ پٙدشٜ خشٚخی ٘تبیح ٞش ٔشحّٝ سا دس فشایٙذ ػبختٗ چبح ٔی

اٌش فشایٙذ ػبخت ٔٛفمیت آٔیض ثبؿذ صفحٝ خشٚخی ٘مـٝ حبفظٝ اػتفبدٜ ؿذٜ سا ٕ٘بیؾ خٛاٞذ داد وٝ چیضی ٞبی ٔـٛستی( دسیبفت وٙیذ. 

 ٔـبثٝ صیش خٛاٞذ ثٛد:

Memory Usage Map: 
Program space: 

CODE used 21h ( 33) of 800h words ( 1.6%)  
CONST used 0h ( 0) of 800h words ( 0.0%) 
ENTRY used 0h ( 0) of 800h words ( 0.0%) 
STRING used 0h ( 0) of 800h words ( 0.0%) 

 
Data space: 

BANK0 used 3h ( 3) of 60h bytes ( 3.1%) 
BANK1 used 0h ( 0) of 50h bytes ( 0.0%) 
COMBANK used 0h ( 0) of 10h bytes ( 0.0%) 

 
EEPROM space: 

EEDATA used 0h ( 0) of 100h bytes ( 0.0%) 
 
ID Location space: 

IDLOC used 0h ( 0) of 4h bytes ( 0.0%) 
 
Configuration bits: 

CONFIG used 0h ( 0) of 1h word ( 0.0%) 
 
Summary: 

Program space used 21h ( 33) of 800h words ( 1.6%) 
Data space used 3h ( 3) of B0h bytes ( 1.7%) 
EEPROM space used 0h ( 0) of 100h bytes ( 0.0%) 
ID Location space used 0h ( 0) of 4h bytes ( 0.0%) 
Configuration bits used 0h ( 0) of 1h word ( 0.0%) 

 
Loaded C:\MyProject\MyProject.cof. 
BUILD SUCCEEDED: Sat Nov 18 01:34:23 2006 

 HexaDecimalؿٛد فبیُ ٟٕٔتشیٗ فبیّی وٝ تِٛیذ ٔیتبٖ تِٛیذ خٛاٞذؿذ.ثؼذ اص ػبختٗ ثش٘بٔٝ خٛد، تؼذاد صیبدی فبیُ دس ٔؼیش پشٚطٜ

 ثیٙیذ.اػت وٝ دس تصٛیش صیش ٔی

 

 Buildَای تًلیذ شذٌ تعذ اس : فایل9 شکل
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 ؿٕب ٚصُ اػت وپی وٙیذ.  Programmerایٗ فبیُ سا سٚی وبٔپیٛتشی وٝ ثٝ خٛاٞذ ؿذ. Burnؿٕب  PICایٗ فبیّی اػت وٝ سٚی 

 

 PICثشای پشٌٚشاْ وشدٖ  DataManپشٌٚشأش  10 ؿىُ

 دسٌیش ؿٛد. I/Oٞبی ای سا دس ٚضؼیت پبییٗ لشاس دٞیذ تب پبیٝػیبٜ سً٘ لشاس دٞیذ ٚ دػتٝ ٘مشٜ ZIFٔیىشٚ خٛد سا دس ػٛوت 

 

 ثش سٚی پشٌٚشأش PIC: 11 ؿىُ
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 سا ثب ٔؼیش صیش آغبص وٙیذ: DataMan Programmerوبس ثب ٘شْ افضاس 

Start →All Programs →Dataman Programmers →Dataman-48XP 
 ػٝ ٔشحّٝ اصّی ٚخٛد داسد: Burnثشای فشایٙذ 

 ا٘تخبة دػتٍبٜ 

 HEXثبسٌزاسی فبیُ  

 PICثش٘بٔٝ سیضی  

 PICؿٛد. ثض٘یذ. فٟشػت چٙذیٗ ٔیىشٚ ظبٞش ٔی PICسا ثشای ا٘تخبة  Alt+Cسا اص ٔٙٛ ا٘تخبة وٙیذ ٚ یب  Device→Select Deviceٔؼیش 

 سا ثض٘یذ. OKٔٛسد ٘ظش سا ا٘تخبة وٙذ ٚ 

 
 Dataman-48XP/UXP٘شْ افضاس : ا٘تخبة دػتٍبٜ دس 12 ؿىُ

٘یشْ   پشٚطٜ خٛد سا ثبسٌیزاسی وٙییذ.   Hexسا فـبس دٞیذ تب فبیُ  Alt+Lسا ثض٘یذ ٚ یب  Loadسا ا٘تخبة وٙیذ یب دوٕٝ  File→Load Fileمسیر 

 Radioؿٙبػیبیی وٙیذ. ٔغٕیئٗ ؿیٛیذ ویٝ یىیی اص        Intel Hexثبیذ ثٝ صٛست خٛدویبس فبییُ سا ثیٝ ػٙیٛاٖ ییه فبییُ        DataManافضاس 

Button ٞبیClear Buffer ٜاػت ٚ ػپغ ا٘تخبة ؿذOK .سا فـبس دٞیذ 
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 Hex: ثبسٌزاسی فبیُ 13 ؿىُ

دٞذ ثٝ ؿٕب اخبصٜ ٔی  DataManایذ. ٘شْ افضاس سا پشٌٚشاْ ٘ىشدٜ PICثبسٌزاسی وشدیذ أب ٞٙٛص  DataManسا سٚی ثبفشٞبی  Hexاوٖٙٛ فبیُ 

 ٔـبٞذٜ ٚ ٚیشایؾ وٙیذ. ایٗ ٔشحّٝ غیش ضشٚسی اػت. ثیٙیذ ثبفشٞب ساوٝ ٕٞب٘غٛس دس ؿىُ صیش ٔی

 
 : ٚیشایؾ ثبفش14 ؿىُ
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دس ٔٙیٛ تؼیییٗ وٙییذ.     Configثب فـبس دادٖ دوٕٝ  DataManٞبی خبف دػتٍبٜ سا دس ٘شْ افضاس تٛا٘یذ ٚیظٌیٔی PICلجُ اص پشٌٚشاْ وشدٖ 

-ٞب ثشای یه دػتٍبٜ خبف ظبٞش خٛاٞذ ؿذ. ثشای دسن دلیك اییٗ ثییت  RadioButtonٞب ٚ CheckBoxٞبی ٔختّف  اص ای ثب ثخؾپٙدشٜ

 سا فـبس دٞیذ. OKٞبی خٛد اعٕیٙبٖ حبصُ وٙیذ ٚ ػپغ دوٕٝ اص ا٘تخبة ٞبی پیىش ثٙذی دیتب ؿیت ٔیىشٚ ٔٛسد ٘ظش خٛد سا ٔغبِؼٝ وٙیذ.

 

 : پیىشثٙذی ٔیىش15ٚ ؿىُ

ٞبی پیىشثٙذی ثبسٌزاسی ؿذٜ ٚ ثیت Hexدػتٍبٜ ٔٛسد ٘ظش ا٘تخبة ؿذٜ، فبیُ  فشا سػیذٜ وٝ ٔیىشٚ سا پشٌٚشاْ وٙیذ. اوٖٙٛ ٚلت آٖ

( دس Progress Barسا ثض٘یذ. یه ٔیّٝ پیـشفت ) Alt+Pسا ا٘تخبة وٙیذ ٚ یب  Device→Program→Autoٔؼیش ا٘ذ. ٔمذاسدٞی ؿذٜ

 ؿٛد. ٔشوض تصٛیش ظبٞش ٔی
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 : پشٌٚشاْ وشد16ٖ ؿىُ

وبسوشدٞبی ثؼیبس دیٍشی ثش سٚی صفحٝ چبح خٛاٞذ ؿذ. Programming Completeوبٔلا ٔٛفمیت آٔیض ثبؿذ پیغبْ  Burnاٌش فشایذ 

 افضاس سا دس آدسع صیش ثخٛا٘یذ:تٛػظ ایٗ ٘شْ افضاس فشاٞٓ آٚسدٜ ؿذٜ اػت. ثشای اعلاػبت ثیـتش تٛضیحبت ایٗ ٘شْ
http://dataman.com/Webpages/Programmers/Product48UXPInformation.aspx 

 

ٔٛاخٝ ؿٛیذ.  Over current detectedیب  Poor contact at pin 13تٛخٝ: دس ٍٞٙبْ پشٌٚشاْ وشدٖ ٔدذد ٕٔىٗ اػت ثب پیغبْ خغبی 

 ایذ.خٛد سا خشاة وشدٜ PICایٗ ثذاٖ ٔؼٙبػت وٝ ؿٕب 

 

 Breadboardتز ريی  PICتسته مذار  .9

ٞبی اخجبسی تٛخٝ داؿت. ثیذیٗ ػیجت ثیٝ دیتیب     ٕٔىٗ اػت خشاة ؿٛد ثبیذ ثٝ اتصبَ پبیٝ PICدس ٍٞٙبْ ثؼتٗ ٔذاس ػلاٜٚ ثش ایٙىٝ ثٝ ساحتی 

 ؿیت ٔیىشٚ تٛخٝ وٙیذ. 

ٕ٘یٛداس   17ؿشح دادٜ ؿذٜ اػت. ؿىُ  MyProjectچـٕه صٖ دس پشٚطٜ  LEDدس پشٚطٜ  PIC16F877Aای اػتفبدٜ اص ثٝ ػٙٛاٖ ٔثبَ ثش

 دٞذ.سا ٘ـبٖ ٔی PIC16F877Aٞبی پبیٝ
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 PIC16F87A/877Aٞبی : دیبٌشاْ پبی17ٝ ؿىُ

پبیٝ  صٔیٗ اػت. Vssٔٙجغ ِٚتبط ٔثجت ٚ   Vddٕٞیـٝ ثبیذ ٚصُ ثبؿذ.  33ٚ  32، 12، 11، 1ٞبی ثب تٛخٝ ثٝ ایٙىٝ ٔٙجغ ِٚتبط، پبیٝ

MCLR/Vpp ٜایؼت وٝ پبیٝ ٚیظPIC  را در وضعیتReset دارد تا زمانی کو منبع ولتاژ مناسب یافت شود. این پایو بو طریق نگو می

 (81شود.)شکل ای توسط دو مقاومت و یک خازن بستو میویژه

 :اػتخذَٚ صیش آٔذٜ دس 18ٞبی ؿىُ ٞب ٚ خبصٖٔمبدیش ٔمبٚٔت

 مقذار قطعٍ

R1 KΩ33 

R2 KΩ10 

C1 Fμ0.1 
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 MCLR/Vpp: ثؼتٗ پبیٝ 18 ؿىُ

ٔشحّٝ ثؼذی دس ثؼتٗ ٔیذاس ػیبخت    دس دیتب ؿیت ٔیىشٚ سا ٔغبِؼٝ وٙیذ. Special Features of CPUاص  14.0تش ثخؾ ثشای ٔمبدیش دلیك

ثبییذ ثیشای اخیشای     OSC1 13پبیٝ ٞب داسای ولان داخّی ٘یؼتٙذ ولان خبسخی ٔٛسد ٘یبص اػیت. PICولان ٔٛسد ٘یبص ثش٘بٔٝ اػت. چٖٛ اغّت 

 ثش٘بٔٝ ٚصُ ؿذٜ ثبؿذ.

غ اٚػیلاتٛس اػیتفبدٜ ویشد. فشویب٘غ    تٛاٖ ثٝ ػٙٛاٖ ٔٙجٔی Arbitrary Waveform Generatorثشای فبص آصٔبیـی یه ٔٛج ٔشثؼی اص یه 

 افضاس اػت.ٚ ٘یبصٞبی ٘شْ PICٔٙبػت ثؼتٝ ثٝ 

  
 : اػیلاتٛس19 ؿىُ

 555: تشاؿٝ تبیٕش 20 ؿىُ

اسصاٖ لیٕت وبس ٔیب سا ساٜ خٛاٞیذ    555ٔٛسد ٘یبص اػت. یه تبیٕش  Timerآٔبدٜ ؿذ یه تشاؿٝ  PCBوبسی سٚی ٍٞٙبٔی وٝ لغؼبت ثشای ِحیٓ

 ا٘ذاخت.

سا حیزف   7805تٛا٘یذ تشاؿٝ ؿٕب ٔی صٖ اػت.چـٕه LEDدیبٌشاْ صیش ؿٕبتیه ٔذاس اصّی ثشای ثؼتٗ یه ٔیىشٚوٙتشِش خٟت اخشای ثش٘بٔٝ 

ثیب تٛخیٝ ثیٝ     LED اػیت. ٔتصیُ ؿیذٜ   Aٞبی دسٌیبٜ  لشٔض سً٘ ثٝ یىی اص پبیٝ LEDثیٙیذ ٕٞب٘غٛس وٝ ٔی .اػتفبدٜ وٙیذ  V5وشدٜ ٚ اص ِٚتبط 

 وٙیذ چـٕه خٛاٞذ صد.فشوب٘ؼی وٝ ؿٕب ا٘تخبة ٔی
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 چـٕه صٖ LED پشٚطٜ: ٔذاس 21 ؿىُ

 ٔذاس ؿٕب دس ٟ٘بیت ٔب٘ٙذ ؿىُ صیش خٛاٞذ ؿذ.

 

 ٖص چـٕه LEDپشٚطٜ  Breadboard: ٕ٘بی 22 ؿىُ

سا ٔغبِؼٝ وٙیذ ٚ ػشی ٞٓ ثٝ ِیٙه آٔیٛصؽ اِٚییٗ پیشٚطٜ ثیب      PICدیتب ؿیت  Breadboardتش دس ٔٛسد ثؼتٗ ٔذاس سٚی ثشای اعلاػبت ثیؾ
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